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Technical Report Documentation Page (TRDP)
Guidelines for Use with Original 1972 Form
Visit the AASHTO R&I/RAC website Report Guidelines and Requirements page for the TRDP template
with instructions, a filled-out example and guidelines. Please check the website for updates.

General Guidance




Use the original 1972 form with modified instructions until otherwise notified.
Even though a modified form will eventually be submitted for approval to the Office of the
Secretary of Transportation (OST), the process will be lengthy and success is not guaranteed.
Our intent is that the instructions for the new form will be consistent with the new instructions
for the 1972 form.
See glossary for explanations of acronyms and how to obtain identifier numbers.

Best Practices






Make sure you are using the form with the most recent instructions on the AASHTO R&I/RAC
website.
Try to keep the TRDP to one page.
Use existing style in form (e.g. font size 8 for text entry). Try to avoid making text fonts smaller
or margins narrower.
Abstracts should be brief (ranging from 200-350 words). See examples below.
Use spelled-out URLs instead of hypertext links (to avoid links that are not clickable in a PDF).
For example, use Leighton L. Christiansen https://orcid.org/0000-0002-0543-4268 instead of
Leighton L. Christiansen

Workflow Suggestions





Develop a process so that all concerned (authors, performing organizations, sponsoring
agencies) know who should be responsible for filling out which field and when. At least one
contact/person should be responsible for making sure that the final TRDP is filled out correctly
prior to publication. Communicate the process to all parties.
o The contact should have input as early in the report publication workflow process and
be as fully integrated in the process as possible. This is to avoid additional work or rework later.
Ask the contractor to send an editable version of the TRDP in case information needs to be
added by the sponsoring agency.
Identify ORCIDs ahead of time for frequently used researchers and collaborators.
o Ask researchers you work with to register for an ORCID on their own (or claim an ORCID
record if they already appear in the database). The performing organization (such as a
university office of sponsored research or departmental contact) may opt instead to
batch register or claim ORCIDs for faculty members.
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Create your own state DOT version of this form for use by your contractors or as part of a report
template. You can edit the form to customize the instructions by adding the Developer tab to
the ribbon in Microsoft Word (File > Options > Customize Ribbon > Main Tabs > Checkmark
Developer box. Once on the Developer tab, click on Design Mode to edit the instructions for
each field. When you are ready to save the edited form, unclick Design Mode.

Individual Field Comments
2. Government Accession No. – Not traditionally used. Unable to identify a suitable field example.
3. Recipient’s Catalog No. – Not traditionally used. Unable to identify a suitable field example.
7. Author(s) – Search the ORCID registry for the number. If the author does not have an ORCID number,
ask the author to register for one. If this is not feasible, then exclude the ORCID number or link.
At a minimum, the ORCID identifier should be displayed as the full iD URI such as:
Leighton L. Christiansen https://orcid.org/0000-0002-0543-4268
As of January 1, 2016, ORCIDs are required for researchers who must comply with the U.S. DOT Public
Access Plan.
10. Work Unit No. – Not traditionally used. Unable to identify a suitable field example.
11. Contract or Grant No. – Include contract, grant or project numbers here. State whether the number
is a contract, grant or project number (e.g. Contract # 8218).
12. Sponsoring Agency Name and Address – Include sponsoring agency name and address. After the
agency name, indicate the source of funding. Add (SPR) after the agency name if any type of SPR funding
is used. Funder IDs will not be required for researchers who must comply with the U.S. DOT Public
Access Plan. Adding the ID to the TRDP is optional. See glossary.
Recommended: Missouri Department of Transportation (SPR)
14. Sponsoring Agency Code – Not used often. Our understanding is that this is an office mailing code
that may be included if a DOT agency such as FHWA or NHTSA is named in the sponsoring agency name
and address field. If it is not named, leave the field blank. See FHWA phone directory for office codes.
Report Example: Work Zone Operations Best Practices Guidebook (Third Edition)
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15. Supplementary Notes –


Alternate title: If the project is known by another title (which differs from the report title),
include here.



Hypertext links: Include a link such as a DOI, URL or PURL to the dedicated web page for the
project (preferred). This page may list one or more URLs for the main report, appendices, data
or errata. If this is not possible, then link to the report archive or repository or link directly to the
report itself. It is understood that you may not know the exact report URL when the report (and
TRDP) are published. PURLs are preferable to URLs, if available.



Copyright statement: Discretionary. Include if needed. See samples in separate document on
AASHTO R&I/RAC website. Note: Some states include a copyright statement elsewhere in the
report, as opposed to adding language to the TRDP.



Disclaimer statement: Discretionary. Include if needed. See samples in separate document on
AASHTO R&I/RAC website. Note: Some states include a disclaimer statement elsewhere in the
report, as opposed to adding language to the TRDP.

16. Abstract – See examples below.
MONTANA DEPARTMENT OF TRANSPORTATION
The purpose of this project was to quantitatively evaluate the relationships between MDT's occupant
protection program activities and seat restraint usage throughout Montana, in an effort to clarify how
MDT's occupant protection programs may affect seat restraint use. Quantitative evaluations of
program effectiveness are critical to optimizing program impacts, yet performing evaluations of these
programs is challenging. Here, a cross-disciplinary research team worked in collaboration with
Montana Department of Transportation (MDT) to produce a quantitative evaluation of four programs
(Office of Public Instruction driver education programs, Selective Traffic Enforcement Programs, Buckle
Up Montana coalitions, and media campaigns) aimed at improving seat belt use rates in the state of
Montana. Program impacts were measured using National Occupant Protection Survey data from 2010
to 2012. The evaluation suggested that MDT’s programs largely operate independently of one another.
Buckle Up Montana program presence was associated with increased seat restraint use rates, and this
was especially true in areas that were not in large media catchment areas. Selective traffic
enforcement programs showed a strong relationship with increased seat restraint use, but this
relationship disappeared in models that included all programs. Driver education program completion
rates were not associated with increased seat belt use. There was no saturating effect of program
impacts, except for media campaigns, where additional dollars lead to improved occupant protection
rates only to a point. Detecting program-specific effects was challenging using the NOPUS data, and the
team suggested additional data collection for isolating particular program effects in the future.
[248 words] [Source]
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LOUISIANA DEPARTMENT OF TRANSPORTATION AND DEVELOPMENT
Reflection cracking is a serious challenge associated with pavement rehabilitation. Practical experience
shows that reflection cracking propagates at a rate of 1 in. per year. The primary objective of this
synthesis study is to conduct an in-depth literature review of research projects on reflection cracking
and a survey of the practices of highway agencies with regard to the types of cracking mitigation
strategy used. Based on the results of the literature review and the survey questionnaire, a
summarized assessment is presented for each reviewed treatment method. Further, a number of
treatment methods were identified for further evaluation. For existing HMA pavements, crack sealing
and overlay, chip seal and open-graded interlayers, full-depth reclamation, and cold-in place recycling
are the most promising treatment methods. For existing PCC pavements, saw and seal, chip seal and
open-graded interlayer systems, and rubblization are the most promising treatment methods. Based
on the results of this study, the research team recommends that a follow-up study be conducted in
order to evaluate the cost-effectiveness of the most promising treatment methods and to develop
guidelines for the control of reflection cracking. The developed crack control guidelines will present
recommended treatment methods for different classes of rehabilitated pavements in order to achieve
adequate control of reflection cracking in a cost effective manner.
[212 words] [Source]

Glossary of Terms
Term
DOI

Definition/Notes
Also known as “Digital Object Identifier.” A DOI is a
structured unique identifier for digital material. A DOI link
is also a persistent URL. The prefix https://dx.doi.org/ can
be inserted in front of a DOI name to create a DOI link.
DOIs are assigned by publishers by using a service
provided by a DOI registration agency (such as CrossRef)
for content such as journals, journal articles, working
papers, books, book chapters, conference proceedings
and papers, dissertations, databases, standards, and data
sets and elements.
As standard practice, DOIs are usually not assigned to
state DOT research because of the nature of state
government as a publisher and the research report as a
publication type.
Search for DOIs
Create shortened DOIs
Journal article example:
DOI name - 10.1016/j.tra.2014.11.002
DOI link - https://doi.org/10.1016/j.tra.2014.11.002
DOI citation - doi:10.1016/j.tra.2014.11.002
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Term
Funding
Agreement
Number
Funder
Registry
(formerly
known as
FundRef)

Definition/Notes
A funding agreement number is the same as a contract,
grant or project number associated with the funded
project.
“Authors acknowledge the funding sources for their
research in their publications. Using the Funder Registry,
publishers can clearly identify the funders who backed the
research.” [Source]

Funder ID
(identifier
or number)

A Funder ID is a unique identifier number for a funding
body. To our knowledge, there are no stated guidelines
for how to cite the funder ID number other than as a URL

Want to learn more?

Funding Data
Funder Registry
Best Practices for
Depositing Funding Data

Download registry file
Funder IDs will not be required for researchers who must
comply with the U.S. DOT Public Access Plan. Adding the
ID to the TRDP is optional. If you wish to obtain one for
your agency, send a request to
funder.registry@crossref.org and ask that your agency be
added to the registry.
Missouri Department of Transportation example:
Funder ID number – 100007251
Funder ID URL – http://dx.doi.org/10.13039/100007251
Other Funder ID examples from the registry:

ORCID

“ORCID is a non-profit organization supported by a global
community of organizational members, including research
organizations, publishers, funders, professional
associations, and other stakeholders in the research
ecosystem.” [Source]
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Term
ORCID ID
(identifier
or number)

Definition/Notes
Acronym for Open Researcher and Collaborator IDentifier.

Want to learn more?
2015 TRB poster

ORCIDs comprise a system of unique identifiers (or URLs)
that distinguish one researcher from another. The
identifier (or number) directly links to the research with
which they are associated or to which they contributed
(such as reports, manuscripts, grants or data). An author’s
ORCID is sometimes referred to more informally as an
ORCID number or ORCID identifier or ORCID ID.

ORCID video (4 min.)
Register for an ORCID
Creating ORCID Records
for Researchers
How to Display an ORCID

Search the ORCID registry (see top search bar on the
home page)
ORCID example:

PURL

QR code

URI

URL

ORCIDs are required for researchers who must comply
with the U.S. DOT Public Access Plan.
Acronym for “Persistent Uniform Resource Locator.”
“PURLs are persistent URLs. They provide permanent
addresses for resources on the web.” [Source]
Acronym for “Quick Response” code. A two-dimensional
barcode which can be scanned using a mobile app on a
smartphone. Connects directly to a website or web page
about an organization, product, event or publication. QR
codes can be inserted in print publications, posters, web
pages, etc. [Source]
Acronym for “Uniform Resource Identifier.” This address
is used to identify the protocol application, the
computer’s Internet address and the file’s location. A URL
is a form of URI. [Source]
Acronym for “Uniform Resource Locator.”
Defined as a Web address, such as
https://www.transportation.gov/
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About QR codes
White paper on QR
Codes and Government
Communications
Definition

Definition

